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INTRODUCTION    
 

Introduction 

Microsoft Word is a word processing software. You can use it to type letters, reports, and other documents. This 

guide introduces users to Microsoft Word 2016. Opening Microsoft Word 2016: 

✓ Click the Start Menu 

✓ Click All Programs 

✓ Choose Microsoft Office 

✓ Click Microsoft Word 2016 

Understanding the Backstage 

All of Microsoft Office 2016 contains the Backstage area. The Backstage is where you manage, save, and open your 

files. Here you can also print, select templates, and complete other useful tasks. Let’s take an in depth look at the 

Backstage. First, click your File tab (found at the top left corner of the window). 

 

                             Backstage 

 

 

 

The first page you see is the Info Page. Info displays your file’s name, size, and authors. You can also see when the last 

AutoSave occurred. AutoSaves are Office’s safety net. Periodically, your computer will automatically save your file as 

a temporary file. If you experience a computer shut down, you can recover some of your work from the AutoSaves. 
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The Ribbon 

The Ribbon is a panel that contains functional groupings of buttons and drop-down lists organized by tabs. Each 

product in the Office Suite has a set of tabs that pertain to the functionality of that application. Each tab is further 

divided into groups such as the Font and Paragraph. 
 

 

At the bottom right-hand corner of some groups, there is a diagonal arrow called a Dialog Box Launcher (See Figure 

4). Clicking this button opens a dialog box for that group containing further option selections for the group. 

 

 

 

 

 

 

Figure 4 - Dialog Box Launcher 

New: You can create a new, blank document or select from Word’s template library. 

Word provides resume, calendar, and flyer templates to help you get started. 

Open: Click this option to open a previously saved file and continue editing it. 

Save: Save your file frequently. You can also click the in the upper left corner. Or press 

CTRL + S on your keyboard at the same time. 

Save As: The first time you save your file you will see the Save As menu. See below for 

more information. 

Save as Adobe PDF: Lets you save the document as an Adobe PDF file. 

Print: Print your document using this screen. We will go into more details about this 

later in the class. 

Share: This is new to Office 2016. This allows you to email your file, upload it to a blog 

site or present your document online. You will need additional accounts to use these 

features, such as a Microsoft Account (to present) or a WordPress account (to blog). 

For this introduction we will not cover these features in-depth but be aware that these 

capabilities exist. 

Export: Allows you to export (or save) your document as a different document type. 

Account: Allows you to change the colors of your Office Background and sign in with 

a different Microsoft Account if needed. 

Options: Gives you access to the advanced features in Word. This feature also allows 

you to rearrange the ribbon or other settings in this application. 

To return to the Word window, click the arrow at the top.    
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Contextual tabs will appear depending on what you are working on. For example, if you’ve inserted pictures, the 

tab appears whenever a picture is selected. 

 

 

 

 

 
 

Figure 5 – Contextual Tab 

 

Customizing the Ribbon 

You can hide/unhide tabs that you do not use or create your own tab of favorite tools. The following explains how 

to customize the Ribbon to build your own tabs and groups. 
 

✓ Click the File tab. 

 

 

 
 

 

Figure 6 - File Tab (Backstage View) 
 

✓ In the Backstage View, click Options. 

✓ In the Word Options dialog box, click Customize Ribbon (See Figure 7). 

✓ Click the New Tab button (See Figure 7). 

✓ A New Tab has been added in the list of Main Tabs. Under New Tab, you will see New Group 

is already selected for you (See Figure 7). 

✓ From the column on the left, select a command from the list under Choose commands from to add 

to the New Group (See Figure 7). 

✓ Click the Add button (See Figure 7). 

✓ The command will be added to your New Group tab. 

✓ To rename the tab or group, right-click on the New Tab or New Group (See Figure 8). 

✓ Click Rename (See Figure 8). 

✓ To hide a tab, remove the check-mark next to the name of the tab (See Figure 8 

 

 

                                                                                                           Figure 8 - Rename New                

Tab or New Group 

                    Figure 7 - Creating a New Tab 
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The Quick Access Toolbar 

The Quick Access Toolbar is in the upper-left part of the main Word window, above the File and Home tabs. It 

provides easy access to commands that you may use often and be customized to your preferences. The following 

explains how to customize the Quick Access Toolbar: 

✓ Click the drop-down arrow in the Quick Access Toolbar (See 

Figure 9). 

✓ In the Customize Quick Access Toolbar drop-down menu, 

click the command(s) you wish to add or remove from your 

Quick Access Toolbar (See Figure 9). 

✓ Click More Commands (See Figure 9). 

✓  In the Customize Quick Access Toolbar window, from the 

column on the left, select a command from the list  

✓ Click the Add button (See Figure 10). 

✓ Click the Ok button (See Figure 10). 

                                                                                          Figure 9 - Customize Quick Access Toolbar 

 

 

 

 

 

 

 

Figure 10 - Adding Commands to the Quick Access Toolbar 

 

Other parts  

At the top of the ribbon are several tabs; clicking a tab displays several related command groups. 

✓ Home: This tab contains the most used commands in word. Some of these include commands to change 

how the text looks and is displayed on the page. The Cut, Copy, and Paste commands are also here. 

✓ Insert: This tab contains commands that allows you to insert various objects such as pictures, tables, and 

shapes into the document. 

✓ Design: In this tab you can change the way the document looks and add visual features. 

✓ Page Layout: Here you can change the position of the text on the page and the document formatting. 

✓ References: You can manage your sources and citations. You can also add a table of contents and footnotes 

here. 

✓ Mailings: This tab lets you set up and use the Mail Merge feature of Microsoft Word. 
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✓ Review: This tab allows you to use spell and grammar check, insert comments, track changes that you have 

made to the document, and use a thesaurus. 

✓ View: In this tab you can change how the Word window looks 

 

The Title Bar 

Next to the Quick Access toolbar is the Title Bar. The Title Bar displays the title of the document on which you are 

currently working. Word names the first new document you open “Document1” until you save it and give it a new 

name.  
 

The Ruler   

The ruler is found below the ribbon. Using the ruler, you can efficiently adjust your page margins and paragraph 

indents.  
 

To view your ruler: 

1. Click the View tab.  
2. Click the check box next to Ruler in the Show group. When the box is 

checked, the ruler is visible. 

 

The Text Area 

Just below the ruler is a large area for your work. The blinking vertical line in the upper-left corner of the text area is 

the cursor. It marks the insertion point. As you type, your text displays at the cursor location. 

 

The Status Bar   

The Status Bar appears at the bottom-left corner of Word. The status bar displays the current page and the word 

count (the number of words) of your document. You can customize what displays on the Status Bar.  
 

 
To customize the status bar: 

1. Right-click the status bar. 

2. Select the options you want displayed from the menu that appears. 

3. Click an item to select it or deselect it. A check mark next to an item 

means it is displayed in the status bar. 
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Document Views 

In Word 2016, you can display your document with one of the following five views: Draft, Web Layout, Print Layout, 

Full Screen Reading, or Online Layout. These settings are found in the View tab. 

 

 

 

✓ Draft View: Draft view eliminates excess space. You will not be able to see margins or the page layout. 

✓ Web Layout: View your document as it would appear in a web browser such as Internet Explorer. 

✓ Print Layout: Shows everything from margins to page layout. It is the most common document view, as it 

shows how the document will look when printed 

✓ Read Mode: You can view how your document looks as a two-page spread. This is a great way to test how 

your document may look on tablet devices. You cannot edit while in this mode. 

✓ Outline View: Displays the document in outline form. You can display headings without the text. If you move 

a heading, the accompanying text moves with it. 

 

NOTE: You cannot edit while in Read Mode. However, you can make some setting adjustments such as changing the 

background to Sepia. You still have full access to the Backstage. To get out of Read Mode, hit the Esc key on the 

keyboard. 

 

Exercise 

✓ Change the document view to Read Mode 

✓ Change the document view back to Print Layout. 
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CREATE & SAVE A DOCUMENT  

 

Create a document 

Once you open Word 2016, you have started a new document. You will see a blank page and a blinking cursor. 

Either before you start or shortly after, you should save your document. Saving a document frequently prevents a 

loss of file if your computer unexpectedly shuts down. At 

this point, you can start entering text. You may need 

several sessions in Word to complete final versions of 

lengthy or complex documents.  

When you type text into a Word document, each 

character appears to the left of the blinking insertion 

point (the cursor) in the document window. The text you 

enter a document can include letters, spaces, numbers, 

and symbols. As you type, the insertion point moves 

across the screen from right to left. 

Try typing: The quick brown fox jumps over the lazy dog. 

Save a document  

The Save As menu appears the first time you save your file. You can also use the Save As menu to save different 

copies of the same file by giving each copy a slightly different file name. This can be done at any time. Example: 

myfile.docx and myfile2.docx. 

You can save your file before, during, or after you have finished your session. Let’s save your file now so you can 

learn about the Saving screen. Open the Save As screen. By default, you have two places that you can save your file: 

(1) directly on your computer, or (2) in a OneDrive Account 

Your OneDrive account is a cloud storage service where you can save your file on Microsoft’s servers instead of your 

computer. This option allows you to access your files from any computer, anywhere that has Internet access. For this 

course we will not be going over OneDrive, only saving our file to the computer. For more information, including 

pricing, please visit onedrive.live.com/about. Unless you want to use a OneDrive account, you will save most of your 

files to a computer. From the Save As screen: 

1) Select This Computer                 2)    Click Browse. 
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You can also use the Save As dialog box to save different copies of the same file by giving each copy a slightly different 

file name. 

1. File Name box: Word will automatically insert a default filename when you first save a document. This 

default is always the first phrase in the document, but you could modify it. Word can handle filenames of up 

to 255 characters. These filenames can include uppercase and lowercase letters, numbers, and even spaces. 

However, they cannot contain the following symbols: < >: * | \ “ ” ? / 

2. File Path: At the top of the box, you can see the file path of the document. The File Path 

shows which folders the document is saved under. 

3. File Location: The default location where the document will be saved is My Documents. To store the 

document in a different location (including flash drives), you can click on the folder or drive on the left side 

of the Save As dialog box. 

4. Similar Files: When you are saving a document, files of similar types will be displayed. For example, if you are 

saving a Word 2016 Document, you will see other Word 2016 (.docx) documents listed. 

5. New Folder: You might consider creating a new folder before saving your file. This step will help you organize 

and find them later. 

6. File Type: When you save a file, you can also change its format type. For example, you can save your file as 

a PDF (protected document format) or as a Word Document. Click the drop-down box to save your 

preferred type. The file type is denoted by the file name’s extension (.pdf, .doc, .docx, or .jpg). 

Exercise 

✓ Save your document to the Desktop. 
✓ Change the name of your document. Use something simple, like the title of the document 

or your last name. 

✓ Make sure that the file type of the document is a Word Document. 

 
 
What happens when you exit out of Word before saving a document? 
 

If you click the “X” before you save, you will 

see the pop-up to the right. 

 

You have three options: 

 

✓ Save to open the Save as dialog box. 

✓ Don’t Save to discard the document. 

✓ Cancel causes Word to return to the document. 
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OPENING EXISTING DOCUMENTS   

 
 

Documents previously stored on your computer or 

OneDrive can be opened for revision. Choose Open 

from the backstage. If the file you that you want to open 

is on OneDrive, then select OneDrive to download and 

edit files stored in your OneDrive account (see page 5 

for more information). Notice that recently saved 

documents are listed on the right side. You can open 

these by clicking on the folder or file name.  

If you don’t see the file that you need, choose Browse. 

This will cause the Open dialog box to pop up. It is very 

similar to the Save As dialog box. Use this tool to search 

for and open your file. 

 

Open Dialog Box 

If you see your file in the current location, select it, and click Open (4). A file saved in a specific folder is opened by 

double-clicking the folder to view the files in the folder (2). For a file saved on a flash drive, select the flash drive on 

the left (1) to view folders and files on it. If you do not remember where you saved the file, you can type the file 

name in the Search Box (3) and click the magnifying glass symbol to search for it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: Search will only look through one drive at a time. To search your flash drive, you need to click the icon located 

on the left side. 

 

Exercise 

✓ Click on the File tab in the upper-left corner. 

✓ Click Open. 

✓ Find the file that you saved in the last lesson and open it. 
 

 

 

 

 

 

 

1 3 
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PRINT PREVIEW & PRINTING   

 

Print Preview 

You can preview your document before you print it. 

This ensures the document will have your preferred 

look/layout. To access the print preview: 

 

1) Click the File tab        2) Click Print. 

 

The Print Preview in Word 2016 is automatically 

displayed with the print menu. To return to the 

Word window without printing, click the arrow at 

the top-left corner. 

 

Printing 

After you create a new document, you can print it. You do not have 

to save the document beforehand. Click the File tab and click 

Print. It’s the same menu from the previous lesson. You can use 

this menu to adjust your current print settings. For example, you 

can specify how many copies you need or the portion of the 

document you would like to print (e.g., single page or paragraph). 

 

Before we go any further, let’s look at other Printing Options 

including selecting a range (set of pages you want to print) 

and choosing a printer. 

 

1. Determine how many copies to print. 

2. Select which printer to use. You should verify that the 

correct printer is selected if you have access to more than one 

printer. 

3. If your printer is capable, you can print on both sides of 

the paper (called duplex printing). 

4. Select the print range (all, specific pages, or selection). 

To print specific pages, type the page numbers in the 

Pages: box. 

5. Select paper size. Typically, you will use 

“letter size” or 8.5” x 11”. 

6. You can opt to print multiple pages per sheet. This will 

decrease the size of your text. 

 

If your printer is Wi-Fi enabled, make sure it is your printer you are printing to! 

1
 

2 

4 

3 

 

6 
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CUT, PASTE & COPY  

 
 

To Cut: means to remove the text from your document and store on your Clipboard   

To Copy: means to make a duplicate of it.  

To Paste: means to deposit the text that you have either cut or copied 

 to another location in your document, or to a different document.  
 

Use format painter to apply formatting settings to another set of text on your document.  
 

Tip: This is great for keeping any headings or titles consistent in your document. 

 

Clipboard 

The clipboard is a feature of all Microsoft Office products. It is a temporary holding place of 

text or images that you have copied or cut. 

 

To see what is stored on the clipboard:  
1.Click on the Home tab. 

2.Click on the right corner button ( ) on the Clipboard group. The Clipboard appears. 

 

 

 

Exercise 1: Copying 

Highlight your name.  

✓ Click on the copy icon (  ) in the ribbon. This creates an invisible copy of your name. 

✓ Move the cursor down a few lines by pressing the Enter key on the keyboard. 

✓ Click the paste icon (      ). This should paste a second copy of your name on your document. Every time 

you click the paste icon, another copy of your name appears. 

 

Exercise 2: Cutting 

✓ Once again highlight your address.  

✓ Click on the cut icon in the toolbar. This cuts the original text (e.g., your address) from the document. It 

disappears from the document and is now on the clipboard. 

✓ Click on a different area of the document. 

✓ Click the paste button. Your address now appears in a new spot. 
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Point 
Size Font 

HIGHLIGHTING & CHANGING THE FONT 

 

Highlighting  

Many of Word’s shortcuts and functions require that you know how to highlight text. 

How to Highlight 

1.Position the cursor in front of the first letter of your sentence. 

2.Click the mouse button once, so that the blinking insertion point is present. 

3.Click on the left mouse button and hold the button down; then drag the mouse over the entire sentence. 

4.Release the mouse button. 

5.Notice that your sentence now appears in a different color. This is called highlighting. 

6.To remove the highlighting, click anywhere outside the highlighted text. 

 

Select with the Shift and Arrow Keys 

1.Position the cursor in front of the first letter of your text. Click the mouse button once so that the blinking insertion 

point is present. 

2.Hold down the Shift key on the keyboard. 

3.As you hold the Shift key, press the right arrow key. This will highlight one letter at a time. 

4.Press the down arrow key until the first paragraph is highlighted. 

5.Click anywhere outside the highlighted area to remove the highlighting. 

          

            If you need to highlight the entire document, press the Ctrl and A keys at the same time. 

 

Changing the Font 

A font is the style, or typeface, of the text. Some of the most common fonts are Calibri, Times New Roman, and 

Arial. The default font of Word 2016 is Calibri. Font sizes are measured in points. Point size is the vertical measurement 

of a character. One-inch equals 72 points. The most common point sizes are 10 and 12 points. This handout is written 

in 11 pt. Arial. 

 

  

 

 

 
 

The ribbon has shortcuts to make it easier to change the size, shape, and style of your font. From here, you can 

Bold (      ), Italicize (     ), or Underline your text. You can also change the point size and the font style. First 

highlight the text, then select the command. If you decide to type in 16 point and Times New Roman font at the 

beginning of your document, this decision will remain as you continue to type (provided you don’t change these 

settings). 

Exercise 

1.Type your name           3. Click the drop-down arrow on the Font menu bar. It’s located under the home tab. 

2.Highlight your name.     4. Select a different font style. 
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LINE SPACING 

 
 

The default line spacing of Word 2016 is multiple spacing. This means when you press Enter, there will be a wider 

space in between sentences. You can change the default line spacing at any time. For example, you can change the 

setting when you open a new document, in the middle of drafting a document, or after you have finished. Some users 

prefer to type their document first and format it (or change the style) after they’ve typed. Others prefer to format 

before typing.  

 

 

 

 

 

 

 

 

Exercise 

✓ Type your name and address as three (3) different lines. It 

should look like this: 

 

                      Twinsburg Library 10050 Ravenna Road 

                      Twinsburg, Ohio 44087 

 

✓ Highlight your name and address. 

✓ Click on the Paragraph icon or on the paragraph’s right 

corner button (      ) to reveal the paragraph dialog box. 

✓ Notice the option to change the line spacing. Click on the 

small triangle under Line Spacing and choose single. 

✓ Click OK. 

 

 

You can change line spacing for an entire document by specifying 

the spacing before you begin typing. Or you can change the line 

spacing by highlighting a specific paragraph (as you just did). 
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SPELLING & GRAMMAR CHECK 
 

 

Grammar Check 

A feature of Microsoft Office that checks for grammar errors throughout the document. 

Spell Checker  

A feature of Microsoft Office that checks for spelling errors throughout the document. 

 

What do the lines mean? 

When you see wavy blue lines, this means that grammar check has found a possible grammatical error. 

When you see wavy red lines, this means there are possible misspellings. If it’s spelled correctly, you can always add 

the word to its dictionary, so it doesn’t keep coming up as a misspelled word. 

 

How to Fix Errors 

✓ You can right-click over the red or green lines. Word will 

display a menu of how to correct any possible mistakes (see 

right) 

✓ You can select Spelling & Grammar under the Review 

ribbon 

 
 
 
 

 

You will see a pane open on the right side of your screen that displays possible 

mistakes in the document. 

✓ Click Change if you agree with Word’s suggestion.  

✓ Click Ignore if you do not agree. 

✓ Click Ignore All if you want to ignore all instances of the word in the current 

document. 

✓ Click Add to add the word to the dictionary of your computer. Click 

Change to change only this instance of the word. 

✓ Click Change All to replace all instances of the misspelled word with the 

suggested word. 

 

AutoCorrect: A default feature that automatically corrects common typos and grammar 

errors without your involvement. You can decide to keep this feature active or turn it 

off. To turn AutoCorrect off:  
1. Click File. 

2. Click Options. 

3. Click Proofing. 

4. Click AutoCorrect Options. 
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BEYOND TYPING: USING THE KEYBOARD 

          
 

The following commands can be used on your keyboard to navigate within Microsoft Word. 
 

 
To move the insertion point 

 

 
Press 

One character to the left or right Left Arrow or Right Arrow 

One word left or right CTRL+Left Arrow or CTRL+Right 
Arrow 

One line up or down Up or Down Arrow 

One paragraph up or down CTRL+Up Arrow or CTRL+Down 
Arrow 

One page up or down Page Up or Page Down 

To left or right end of current line Home or End 

To first or last character of the entire 
document 

CTRL+Home or CTRL+ End 

 

Basic Shortcut Keys for Navigating Through Documents 
 

The following are keyboard shortcuts (keys are bolded): 
 

 

Function 

 

 

                        Description 

 

Keyboard Shortcut 

New Creates a new blank document Ctrl + N 

Open Opens a saved document Ctrl + O 

Save Saves the current document Ctrl + S 

Print Prints the current page Ctrl + P 

Undo Cancels the last change to the document Ctrl + Z 

Copy Copies the selected text to the clipboard Ctrl + C 

Paste Pastes the cut or copied selection Ctrl + V 

Cut Removes the selection and places it in the 

clipboard 
Ctrl + X 

Find Finds text within the current document Ctrl + F 

Help Opens Word’s Help Center F1 

 Displays the next page Page Down 

 Moves the cursor to the top of the next page Ctrl + Page Down 

 Displays the previous page Page Up 

 Moves the cursor to the top of the previous page Ctrl + Page Up 

 Moves to the end of the current line End 

 Moves the cursor to the end of the document Ctrl + End 

 Moves to the beginning of the current line Home 

 Moves the cursor to the beginning of the document Ctrl + Home 
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